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License Statement

This software is protected by both United States Copyright Law and
International Treaty Provisions. SNA Inc. grants you this license and your
continued use confirms your agreement. Therefore, you must treat this
software “just like a book”, with the sole exception that SNA authorizes
you to make archival copies of the software for the purpose of
protecting your investment from loss.

The phrase “just like a book” means that the software may be used
by any number of people and may be moved from one computer to
another, so long as there is no possibility of it being used on more than
one computer at the same time.

This License Statement shall be construed, interpreted and gov-
erned by the laws of the State of Florida.

Limited Warranty
SNA warrants that the diskette and manual are not physically
defective; that the program is properly recorded on the diskette; and
that the manual is substantially complete and contains all the informa-
tion SNA deems necessary for use of the software. The Limited Warranty
is in effect for thirty (30) days from the date of purchase and is extended
only to the original purchaser.

SNA, INC. MAKES NO OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED,
REGARDING THE ENCLOSED COMPUTER SOFTWARE, ITS MERCHANTABILITY
OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.THE EXCLUSION OF IMPLIED
WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION
MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC
LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH
VARY FROM STATE TO STATE.

Product Support
If you should experience a problem using the software, we recom-
mend the following:

1. Review the User Manual.

2. Verify that your system hardware and software meet the require-
ments of the software.

3. If you still cannot solve your problem, contact SNA technical support
at (407) 241-0308 between 9:00 a.m and 5:00 p.m. Eastern time.
Please be seated at your computer when you call, so our support
personnel can “walk” through the problem with you.




Contents

I ———— A R A £ 1. M SR YU NS ——

Introduction ..
The Cltaleg Englne
The Search Engine ...
The Print Engine ............
The Export Engine ..
What You Need . PR
Software Requnrements
Hardware Requnrements e
Other Requirements ............cccceuee.

Getting Started .. ks badbubaln Connd
Check ‘r’eur foLlne Peckege WY TR
Complete and Mail Reglstretnen Cerd Al o L SRR
Copy Your Program Disk ............ccoceiiiiiininnnnnn,
S T TR SR AR

Using OffLine ..

Catalog ...
Using the Seerr.:h Englne hive s bbb e s .. 10
Basic Search Method .. KRR ILAIAE e et ok L+ N
Advanced Search Methed RPRPERRRTE AR 41t cliadt 10 < I
Adding and Editing COmments ...........ccoereisiinniisiiisiinen 19
Tips & Tricks in the Search Window .........cccocuveeveeiiiiinnne 20
OffLine’s Menus .. arnsesmensaidsiendbiorbane AR RIS L
Printing Floppy DISk Lebele SRR SR SRS e g
Label Printing Preferences IETIRID S R Py A
Label Description 29
IRDOrtIng the Cathlog ..............ccicnmnaisiibibansiivsiviissans iassszees S0
BRI PRPOTETRNERS. .. ......ovicorvarsaismssirsinipanseorasanssssiibntnd |
Using Multiple Catalogs .............cccovuemineisosnisassiaerssssessssssnss 34

BERRRHONE B ANSWETS ............coivecssemvsmnisarsisnssssosssbsssssassasannsunns 34

L conedifidintin . otk S TR . 4,47 e I e 37

BIINEIIE ..o oo e ennenentonnnnonnsnsvensaransnnosnsssansasnes shaibnsssnsiiotronasabans 38

Export Format (Comma- or Tab-delimited) ................c...... 38

NI D WN = =



Introduction
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Congratulations on your purchase of OffLine, the
disk database. You possess what we believe to be the
complete solution to disk and file management.

OffLine is unique among Macintosh disk utilities.
Unlike other utilities, it was designed to keep track of
unmounted — or offline — disks. This means that, once
the program knows about your disks, it can perform all
of its functions without requiring you to mount them.

OffLine keeps track of your disk files in its own
database, or catalog, which resides on your hard drive.
The first time you launch OffLine, it creates and opens
a catalog called “OffLine™ Catalog” in the folder from
which you launched OffLine. The name and location of
this catalog is “remembered” between sessions, so it is
always opened automatically when you launch OffLine.

If you wish, you may create and use additional
catalogs, and switch among them at will. At any given
time, however, only one catalog can be active.

The program’s functions all access the active cata-
log automatically, and are based on four components
of the program, called “engines”:

The Catalog Engine

While traditional databases require you to enter
information, OffLine does this automatically. Catalog-
ing a disk (i.e., getting its information into the catalog)
is as simple as inserting it into the disk drive (in the




case of floppies) or clicking a button to select a disk on
your desktop. All the information about the disk and its
files is quickly stored in the catalog. If the disk is a
floppy, it is ejected, whereupon you may insert the
next disk to be cataloged. This can be repeated as
many times as you like, whenever you like.

If you have attached a comment to a file using
Finder's Get Info command, then OffLine will retrieve
it, and attach it to the file's entry in your catalog.

When cataloging files, OffLine recognizes and performs
special processing on Stufflt™ (including the Classic
and Deluxe versions), Compact Pro™, and AppleLink™
archives. The catalog engine automatically extracts in-
formation about each file in an archive, making a
separate catalog entry for each. Similarly, the catalog

engine includes intelligent support for files compressed
by DiskDoubler™.

The Search Engine

Once your disks have been cataloged, you can
locate any file or group of files with ease. The search
engine offers an extremely flexible array of search
options, ranging from simple to sophisticated. When
OffLine has found what you were looking for, it tells
you all about each file, and — most importantly — on
what disk each file is located.

OffLine provides two levels, or methods, for search-
ing the catalog: Basic and Advanced. The basic search
method allows you to find any file, or group of files, by
specifying a disk and/or scanning the catalog for file
names that contain a search string that you provide.




You can further restrict your search to files created by
a particular application. OffLine lists all the files that
match your search criteria. A single click on any of the
files found reveals its full path name, size, creation
date, modification date or version number, Finder label
(under System 7.0 or later), and the name of the
application that created it. If you click on a file that is
contained in a Stufflt, Compact Pro, or ApplelLink ar-
chive, the name and location of that archive is dis-

played.

The Advanced search method was designed for
users who are familiar with Macintosh file signatures
(types and creators), and who need the flexibility to
conduct highly sophisticated searches of the catalog.
This search method allows you to search on any combi-
nation of name, type, creator, and Finder label (System
7.0 or later), and displays signature information about
the files that are found.

The Print Engine

Even when you know what disk to look for in your
collection, finding a specific disk can be time-consum-
ing, especially if your disk labels are out of date, incon-
sistent, or even non-existent. OffLine’s print engine
offers a simple and elegant solution, by printing clear,
professional-looking floppy disk labels on standard la-
bel sheets designed for laser and inkjet printers.

If you're a real stickler for organization, and want
the ability to physically locate a disk fast, then you will
want to take advantage of OffLine’s automatic num-
bering feature. When a disk is cataloged, OffLine as-
signs it a unique serial number. When you print disk
labels for floppy disks, you can elect to have the serial




numbers printed on the labels, so you can physically
file your disks by number. This makes locating a de-
sired disk quick and effortless.

The Export Engine

Finally, we recognize that information is a valuable
resource, and that we cannot possibly anticipate all the
creative uses to which you may want to put this informa-
tion. So we made it very easy to export the contents of
the catalog for use in virtually any other application —
even those on non-Macintosh computers.




What You Need

Software Requirements

OffLine requires System version 6.0.5 or later, and
is compatible with MultiFinder. This software is avail-
able from authorized Apple™ dealers and from many
online services.

OffLine is System 7 friendly, offering a number of
features that are available only if you are running
System 7.0 or later.

OffLine supports Balloon Help™ under System 7.
To get help, simply turn on Balloon Help and pass the
cursor over an object on the screen.

Hardware Requirements

OffLine will run on Macintosh Plus or later model
computers with a hard disk. Label printing requires a
page printer (laser or inkjet) that supports either
QuickDraw or PostScript.

Other Requirements

If you wish to print floppy disk labels, you'll need
sheet-fed adhesive labels (Avery # 5196 or equivalent).
These are available from many computer and office
supply dealers.




Getting Started

Check Your OffLine Package
Your OffLine package should contain an 800K dis-

kette and a registration card, in addition to this man-

ual. Contact your dealer or SNA if you are missing any
of these components.

Complete and Mail Registration Card

You should complete and return your registration
card immediately. As a registered user of OffLine, you
are eligible for free technical support, reduced prices
for upgrades, and news about other products that may
interest you.

Copy Your Program Disk

Before using OffLine, make a backup copy of your
OffLine disk, and put the original disk away in a safe
place. Then use the copy to install or reinstall OffLine
on a hard disk.

You are authorized to make a single backup copy for
safety, but you must ensure that OffLine is used on
only one computer at a time.

Installation

To install the application, select the OffLine applica-
tion icon on your copy of the distribution diskette, and
drag it into a folder on your hard disk. If there was any
last-minute information that did not make it into this
manual, then a ReadMe document will be on your disk.
You should read this, if present, before you continue.




Using OffLine

The first time you launch OffLine, it creates and
opens a catalog named "OffLine™ Catalog” in the
folder from which you launched the program. When
you quit the program, OffLine saves the name and
location of the catalog in a document named “OffLine
Prefs” in a folder named “Preferences” in your System
folder. Therefore, each time you launch the program, it
opens the most recently used catalog.

Whenever you launch OffLine, its main window
appears, containing information about the catalog. Be-
cause your catalog will initially be empty, the first thing
to do is to catalog one or more disks.

Catalog

Choose Catalog... from the File menu. OffLine’s
Catalog dialog box appears.

To catalog a floppy disk, simply insert it into a
floppy drive. Within a few seconds, OffLine will mount
the disk, add it to the catalog, and eject the disk. To

catalog a group of disks, simply insert them, one after
another.

To catalog any other disk on your desktop, click
the Drive button, until you see the disk you want, then
click the Catalog button.

Don't worry if you're not sure whether a disk has
already been cataloged. When OffLine determines that
a disk is already in the catalog, it refreshes the catalog,




removing references to files that are no longer on the
disk, adding any new files, and updating dates and
sizes, as required.

OffLine “knows” whether a disk has been previously
cataloged by comparing not only its name, but also its
initialization date, to those in the catalog. If you insert
a disk that has never been cataloged — but has the
same name as a disk that has been cataloged — then
OffLine will alert you, and suggest that you use the
Rename checkbox to eliminate the duplication.

(—— Hord Disk (“orive ) [ fject ]

Files: 3288 Folders: 276

Serial number: First available  w|

[[] Rename disk to:
(2 Ignore system files
[<] Auto-Catalog when disk is inserted

Active Catalog: " junk™
Status:  Waiting Tor disk

For inquiring minds, here’s a description of the
check boxes, buttons, and messages.

The "Serial number" popup menu allows you to
control how serial numbers will be assigned to new
disks in the catalog. You can choose:




[ "Next sequential," which tells OffLine to assign a
number one greater than the highest serial num-
ber in the catalog.

(3 "First available," which assigns the lowest available
serial number. This is useful if you have

uncatalogued a disk, and wish to re-use its serial
number.

 Or, if there are gaps in the serial numbers (be-
cause you have uncatalogued one or more disks),
you can choose a particular serial number from
among those that are unused.

By default, the Auto-Catalog option is checked. This
means that OffLine will mount, catalog, and eject a
floppy disk as soon as you insert it in the drive. If this
box is unchecked, however, the disk will be mounted,
and its name will be displayed in the upper-left corner
of the dialog — but the cataloging will not begin until
you click the Catalog Disk button.

There are two reasons why you might want to
uncheck the Auto-Catalog... box. First, you have the
opportunity to change your mind if you decide that
you don‘t want a particular floppy disk cataloged:
Simply click the Eject button to remove the disk with-
out cataloging it.

Second, cataloging disks provides a good opportu-
nity to think more systematically about how you name
your disks. You may find, once a disk has been mounted,
that the disk’'s name is confusing or obsolete. Clicking
the Rename disk... box displays a text box in which you
can type a new name for the disk. The name you enter
will be used to rename the disk before it is cataloged.
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The Rename disk... check box is disabled if the disk you
inserted is locked. If you wish to rename a locked disk,
eject the disk, unlock it, then insert it again.

The Ignore system files box is normally checked.
This option acts as a filter that prevents common
Macintosh system files (e.g., “Desktop”, “Finder”, “Sys-
tem") from being cataloged. If you want system files
on your disks to be cataloged, click the box to uncheck

it.

The Status area displays informational messages. If
no drive has been selected, the message reads "Wait-
ing for disk.” During the period in which a disk is being
cataloged, the message reads “Cataloging”, then “5av-
ing entries”.

Once a disk has been cataloged, the message tells
you the unique serial number that OffLine has assigned
to the disk. This is the number that will be printed on
the disk label if you choose that option.

Using the Search Engine

The appearance and operation of the Search win-
dow depends on your choice of search method. At any
given time, you can use either the Basic Search or the
Advanced Search method by selecting it from the Dp-
tions menu.

Basic Search Method

The basic Search window consists of five areas.
Counter-clockwise from the top, they are:
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Request Area
Disk List
Action buttons

Info Area

EE Ve

Results List

[ Include folders Name Created by...
[ include comments |Contains | Any T

[(] Selected disk only
Sort by [(isk Name - |

2 1=-8yQueil Arohive

I A Thankcs giving. ®1
15 Disk 2 = ADF A Seroo thi ond p=
8 Diskfupress || i
I HARD DISK

B HiyperCard iheas

9 MFS2

& OfflLins 2.0

o Quickeys 2™ [xtras =4
10 SAM® Program Disk %1 il

11 System 7.0
[ Ewport.. |

Request Area

The request area, on top, is where you define your
search criteria. You can elect whether to search for
files on a particular disk or on all disks. You can limit
the search to files in the catalog whose names match a
particular string of characters, called a search string.
You can also restrict your search to those files created
by a particular application, by selecting the desired
application from the popup menu labeled “Created by.”

2l



The popup menu below “Name” extends the power
of string searches by allowing you to control how strings
are matched. This menu, which applies only when you
specify a search string, contains the following choices:

(d Contains — Catalog entries whose names contain
the search string will be found

(A Starts with — Catalog entries whose names begin
with the search string will be found

Q Ends with — Catalog entries whose names end
with the search string will be found

d Equals — Catalog entries whose names exactly
match the search string will be found

The string matching method defaults to Contains.
Regardless of which method you use, case is not signifi-
cant: “July” and "JULY" are treated as matches.

The checkbox labeled Include folders allows you
to extend the scope of a string search to folders and
archives as well as files. For example, suppose you type
“July” as a search string. If the checkbox is not checked,
then OffLine will find all files whose names match
"July” (assuming they match any other criteria you may
have specified), However, when the Include folders
checkbox is checked, OffLine will also find files within
folders and archives whose names match “July,” even if
the file names themselves don’t match the search string.

The checkbox labeled Include comments allows
you to extend the scope of a string search to comments
attached to files, as well as the files themselves. For

12



example, suppose you type “Apple” as a search string.
If this checkbox is checked, then OffLine will find not
only file names that match, but also files whose com-
ments contain “Apple.”

The checkbox labeled Selected disk only allows
you to decide whether your search will cover the entire
catalog, or just those entries on a selected disk. If you
know which disk contains the files you are looking for,
then select the disk in the Disk List, and check the box.
The search will be much faster.

Disk List

Disk names are sorted alphabetically. To change
the sort order, use the “Sort by” popup menu.

Whenever you select a disk from the Disk List,
information about the selected disk is displayed in the
Info area.

You can browse the entire contents of a disk by
double-clicking or option-clicking a disk in the Disk List.
A browser window will appear containing a graphical
view of the folders and files on the disk. If there are
any archives, then each will be represented by the icon
belonging to the application that created it (i.e., Stufflt,
Compact Pro, or AppleLink), and its component files
will appear below. To expand a folder, click on the
small arrow to its left. To collapse a folder, click again
on the arrow.

If, for some reason, you wish to uncatalog a disk,
simply click on the disk icon in the Info Area and drag it

13
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T T T R AN R A O R
w [ Aldus Pagetiaker 5.0
<& Aldus PageMaker 5.8 - Application
P [ Avery Labels sit
B Calibration ptS - Aldus PageMaker 5.8 document il
[E Character Set - Aldus PageMaker 5.0 document
[l Deutsch
v [ KernEdit
<A KernEdit 2.0 - Application
[El KernEdit 2.0 ReadMe - SimpleText document
KernEdit Help = KernEdit 2.0 document
B KernEditDefsult words = KernEdit 2.8 document
[E Master Kern List.d 1.1 - KernEdit 2.0 document
b £ Sample KernData™
[E PHS PestSeript Printing Chart = Aldus PageMaker 5.0 document
Bl PMS.0 Help - Aldus PageMaker 5.8 document
[ PMS @ Help note = Aldus PageMaker 5.0 document
B Proposal
ReadMe - SimnpleText document
Bl Readre2 - SimpleText document
b O Seripts

Click on arrows to expand / collapse folders m

to OffLine’s trash can. This action removes information

about the disk from the catalog, but has no effect on
the disk itself.

Results List

After clicking the Search button, the Results List is
filled with all the files that matched your request,
together with the names of the disks on which they
are found. Clicking on the name of a file in the Results
List displays information about that file.

If you click on a file name, then a File Info icon
appears in right side of the Info area. Click on this icon
to attach a comment (up to 200 characters) to that
file's catalog entry, or to view and edit an existing
comment. Double-clicking on a file name has the same
effect.

14
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[ Include folders Nome kb o4
[] Include comments [Contains v Rny . |
[] selected disk only | e 08
Disk
| 2 1-5yQuest Archive p| [HyperCard ideas  Art ideas
1 Alex. Thanks giving. ™1 . HyperCard eas Button ldeas
13 Drisk 2 = ADF A SmaoolhF ont m periCard deas Card ldeas
| 5 DiskExpress || :L‘ perCard ideas Stack |deas

e 8

HyperCard ldeas

THOl| Serial ®: 16 Cataleged:7/29/91
Bize: B0E 840 Files: 5
F_.i Free Spase: 8,160 Falders: |

It's easy to tell whether a file has an existing com-

ment. Files with attached comments are displayed in
boldface type.

The box surrounding the “File Name” column heading
indicates that the results list is sorted by file name. To
view the list sorted by disk name, click on the "Disk”
column heading.

If you want to save the results of your search for
later perusal, or for use in another application, click the
Export button. The format in which your search results
are saved is determined by your choice in the "Export
preferences” dialog, accessed from the Edit menu (see
Export Preferences, below).

To illustrate a string search, you could type the
word “ideas” in the text box (top center), and click the
Search button.

15
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[ Include Tolders Neme Created by...
[ Include comments  [Contains | finy |
[ Selected disk only  [{geas 9 maiches
Sort by [Disk Neme Disk
rom Cralg Backup1 /9 whArt deas <
| Fully Powered Mac Utilities]  |Backupt /9 nButten Ideas
13 Gondies Backup1 /9 wilard Mess
S Ooodies2 Backip! /9 »Stack Ideas
I HARD DISK HyperCard ldeas  Art Ideas
8 HyperCard ideas [HyperCard laeas Button ideas I
9 LaserMAX Fonts Disk 3 HyperCard Ideas
6 MacDTES Stacks ® Jan 197N Dise Tracy kcan ldeas
4 Mafl Order [HyperCard ldeas Stack ldeas
10 Harch 'S0 CHUO HBC DO
1My Fiotures A-1
Card ldeas - HyperCard docurnent
Paih: kiea Stacks:
Size: 134 656 Label:  None |ig
| Ewporl... Created: 11/23/87 .
Mad MVers:11/7/88

The Results List shows all the files in the catalog
whose names contain the string “ideas”. Click on any
item in the file list, and its attributes appear in the Info
area below. If the selected file is a program (applica-
tion, system extension, etc.) that contains a version
number, then the version number will be displayed
instead of a modification date. If you are running
System Software 7.0 or later, then the file's label (as
assigned in the Finder) will appear.

When performing a search, you can also narrow
the search request to find only those files created by a
particular application. To find all HyperCard documents
on all the cataloged disks, make sure the checkbox
labeled “Selected disk only” is not checked (so that the
search is not limited to a single disk), then Select
"HyperCard” from the “Created by” popup menu.

Whenever you catalog a disk containing an application
previously unknown to OffLine, that application is per-
manently added to the “Created by” popup menu.
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Advanced Search Method

If you use OffLine’s Advanced Search Method, you
will see more popup menus in the Search window,
and additional file information displayed in the Info
Area.

W ———— IO

[] Include folders Name _ Label Type Creator
[ Include comments |Contains w| |Any w| [STAK w (Wit w
[] selected disk only .

Sort by [Disk Name -] Disk

From Craig Drise Tracy PostEvent
Fully Powered Mac Utilities brisc Tracy PostEvent stack
[ Drisc Tracy PrintField 1.1
PrintField Example
Progress MCHD 1.1

perCard ideas MacDTS Stacks ® Jan 1990 Q& AStack221
asertiA¥ Fonts Disk 3 Q& ASteck 401
MacDTS Stacks & Jan 1950 Q) function

'l l‘ i il

Quickeys scorssorws

My Piotures A=l ReadCatl KFCN 1 562
i
- : Path: Comm - Applel ink 6.0 T
Size: 420 362 Label: Mo i@
| Emport... Created: 9/5/%0 Type:  STAK L
Had /Vers - 10/29./90 Creator :  WILD

The popups on the right allow you to restrict your
search to files whose signatures (types and creators)
match what you select from the menus.

If you are running System 7.0 or later, you can use
the Labels popup menu to further restrict your search
to files having a particular Finder label.

Note what happens, for example, if you limit your
search to those files whose type is “STAK" and whose
creator is "WILD"” (these comprise the signature for all
HyperCard stacks). After clicking on the Search button,
the Results list is filled with all the HyperCard stacks in
the catalog.

17




Files contained in a Stufflt™M, Compact Pro™, or
AppleLink™ archive are marked with “»". If you click
on one of these files, then the archive’s name (instead
of the file's folder path) is displayed in the Info area.
Files that have been compressed by DiskDoubler™ have
“(DD)" appended to the file’s description in the File

Info area.

You can combine different restrictions in your search
request. If you enter “stack” as a search string, and
choose “STAK” and “WILD" with the signature popups,
then all HyperCard stacks whose names contain the
search string are displayed.

=== llLne" Lataly e

O !alnﬂn_d disk only [siac s
Sortby [DiskName =]  Disk
From Craig Dise Traey Fodify Slack Script
ully Powered Mao Hilities Dise Trasy PEET Black
Goodies [ise Trasy PastEvent stack
Doodies2 MacDTS Stacks ® Jan 1990 O& AStack 321
HARD DISK HARD DESK & A Stack 4.0.1
HyperCard ldeas HARD DISK
LasertAX Fants Disk 3 Drise Tracy Riddle stack
HacDTS Stacks ® Jan 1990 Drise Tracy Samgleromd Stack
Mail Order HyperCard ldeas Stack Meas
Harch 90 CHUG HC DOM Drise Tracy Siriph Slack
My Pictures A-1 [ige Tracy SysEnv, the Slack
2]
Ostack 2.0 - HyperCard docurment
Path: Comm AppleLink &.0: .
Stze : 428,362  Label:  None |ia
[ Ewport.. | Created: 9/5/%0  Type:  STAK -
Hed /Vers - 10/25/50 Creator: WILD

Similarly, you could restrict your search to all files
having a particular signature and residing on a particu-
lar disk. Simply select a disk by clicking in the Disk List,
check the check box above the Disk List, and choose
the signature from the popup menus.

18



Whenever you catalog a disk containing an application
previously unknown to OffLine, that application’s file
type and creator are permanently added to the Type
and Creator popup menus.

Adding and Editing Comments

Whenever file names appear in the file list, you can
annotate any individual file with a free-form comment.
Either select a file, then click on the File Info icon, or
double-click on the name of a file. A comment dialog
box appears. Type any comment up to 200 characters,
just as you would in Finder's Get Info box. If you click
on the OK button, the comment will be permanently
saved in the active catalog.

File Comment for “AreaCode”™

This is a desk accessory used for quick lookups of telephone
area codes and time zones.

[ Cancel |
RRARITRTR A R ‘

When you perform a search, and file names appear
in the file list, you can tell at a glance which files have
comments attached to them. Files with comments are
displayed in boldfaced text. If you double-click on a
file that already has a comment, the comment will be
displayed, and you can edit it if you wish.

To search for files whose comments contain a particu-
lar string, check the “Include comments” checkbox.

19




Tips & Tricks in the Search Window

J

To get an instant look at statistics about the active
catalog, option-press the window’s title bar. As
long as you hold the mouse button down, catalog
statistics will appear in the File Info area at the
bottom of the window. For more complete infor-
mation, choose Statistics... from the File menu.

Both the Disk List and the Results List support
auto-scrolling. Instead of using the scroll bars to
move through a list, you can press and hold the
mouse button as you move the cursor toward the
top or bottom of a list. When the cursor reaches
the top or bottom, the list will scroll automatically.
If your keyboard has arrow keys, then these will
also scroll the lists.

Double-click or option-click on a disk name to
browse the contents of a disk.

Double-click on a file name to add or edit a com-
ment attached to the file. File names displayed in
boldfaced text have comments attached to them.

Sort the Disk List by free space, to help you learn
which of your disks has enough room to accom-
modate a particular file or folder.

To remove a disk from the catalog, select it in the
Disk List, then drag its icon (in the Info area) to
OffLine’s trash.

If your catalog is very large (say, over 10,000
files), and you find that searching is getting slow,
consider creating new catalogs, and dividing your

20




disks among them in a way that makes sense to
you.

When you perform a string search, pop up the
string search menu to gain further control over
how strings are matched.

If you know which disk contains the document(s)
for which you're searching, then select that disk
and check the “Selected disk only” checkbox. The
search will be completed much faster.

Available memory places limitations on the num-
ber of files OffLine can display in the Results List.
If your catalog is large, and you perform a very
broad search (e.qg., all files that contain the letter
“a"), there may be more matching entries than
can be displayed, and the following alert will ap-
pear:

Toa many malches lo display.

Do you wanl 1o expart the maiching items lo 8
report file?

| [ Ewport the metches... |

This often means that you cast too broad a net in
your search request. If you click Cancel, you can
try again with more specific search criteria.

If you really want to find all the files that match
your request, then click "Export the matches,”
and OffLine will direct its report of all matching
files to a document that you can peruse and print
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with any word processor, spreadsheet, or data-
base management system. The format of this re-
port is determined by your choice of export for-
mat (choose Export preferences... from the Edit
menu).

OffLine’s Menus

OffLine’s primary functions are easily accessed from
the File menu.

New... N
ODpen... %0
Catalog... ®6
Statistics... ®71
Export...

Pack catalog
Duplicates...

Page Setup...

Print Labels... %P
Quit ®0

3 The New... command creates and opens a new
(empty) catalog.

3 The Open... command opens an existing catalog
(after closing the current catalog). The next time
you launch OffLine, the last catalog you opened
will be opened automatically.

3 The Catalog... command opens the Catalog dialog
box. Choose this command whenever you want
to add new disks to your catalog.
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The Statistics... command displays summary infor-
mation about the contents of the current catalog.

The Export... command is used to extract the infor-
mation from the catalog and save it in a format
suitable for use with other applications, such as
word processors, spreadsheets, and database man-
agement systems. See Exporting the Catalog,
below.

Pack catalog performs two functions. First, it re-
builds the active catalog, physically removing any
entries that have been marked for deletion. Sec-
ond, it checks the catalog structure for integrity,
and attempts to repair any damage that may have
occurred.

Duplicates... is a powerful command that you'll
probably use only occasionally. Its purpose is to
scan the entire catalog (or a selected disk in the
catalog) for files that exist in more than one place.
This information is recorded in a text file that you
may peruse and print using TeachText or your
word processing application (see Export prefer-
ences below). The report includes each file's cre-
ation and modification dates, so you can easily
determine which of the duplicates are more re-
cent. Using this information, you may wish to
“clean up” your disks, by throwing away redun-
dant or obsolete copies of duplicated files.

Normally, the entire catalog is searched for dupli-
cates. However, if you select a disk from the Disk
List and check “Selected disk only,” then only the
selected disk will be searched for duplicates.
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You can control the behavior of the Duplicates

command by choosing Duplicates preferences...
from the Edit menu.

[ Duplicates
|

Report files as duplicated if:
(O Names, types & crealors match
® Names match

[] Sizes match

[] Don't look inside archives

Cancel )

The radio buttons determine how rigorous the
search will be. If you pick “Names, types and
creators,” then files will be considered duplicated
only if they have the same name, they are the
same type of document, and they were created
by the same application. If you pick “Names match,”
then files with the same name will be considered
duplicates.

Check “Sizes match” if you want files to be consid-
ered as possible duplicates only if they are the
same size.

Check “Don't look inside archives” if you do not
want the search for duplicates to include compo-
nents of compressed archives.
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(J Page Setup... displays the standard dialog box for
your printer. For label printing, you should select
portrait orientation and 100 percent scaling. If the
dialog box has a button labeled “Options,” you

should click on it, and check the box marked
“Larger print area.”

i Choose Print Labels... to select disks from the cata-
log for which you want to print labels. See the
next section, “Printing Floppy Disk Labels.”

J  Quit ends the session and returns you to the Finder.

Printing Floppy Disk Labels

The Print labels... command lets you print one or
more floppy disk labels.

Select disk(s) for printing

2 Fully Powered Mao Utilities
i 3 Goodies
| | * il e o
5 HARD DISK
& LaserMAX Fonts Disk 3
T MacDTS Stacks & Jan 1990
1 a1] O des

9 Harch 90 CHUG HC D0

® Sort by name
(O Sort by serial #

(] Folders only
Select starting label

19 My Potires o7 DEE
12 Oet 90 CHMUG HCDOM .@@
15 OCT 90 CHUGDOM/ A

14 OCT 90 CrLUGHDM. B @

16 Dot DOM
L O L e 2 10
18 OffLine 2.0 Bets

Serial ®: 127 Files: 2

o )
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To select a label for printing, simply click on a disk
name. To select a range of disks, hold down the Shift
key while dragging the mouse over the desired range.
To select individual disks that are not together in the
list, hold down the command key while clicking on
each desired disk.

Each time you click on a disk name, its serial num-
ber and the number of files and folders on the disk are
displayed below the list.

Click on one of the radio buttons to sort the list by
name or by serial number.

If you prefer that folder names appear on the
labels instead of file names, then check the “Folders
only” checkbox.

The buttons in the lower right allow you to tell
OffLine where to print the first label on the first label
sheet. If you have a partially used label sheet, you can
avoid waste by beginning on the first unused label. If
you are printing more than nine labels, then printing
on subsequent pages will always begin with the first
(top left) label on the page.

Some laser printers have difficulty feeding partially used
label sheets, and may jam. Consult your printer manufac-
turer or dealer if you are uncertain about feeding
partially used label sheets.

When you click 0K, you will see the standard print
dialog for your printer. Click 0K again to begin printing
the labels.
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Be sure to check “Larger print area” from the Options
in your printer’s Page Setup dialog.

Label printing requires sheet-fed adhesive labels
(Avery # 5196 or equivalent), and a page printer (laser
or inkjet).

Label Printing Preferences

You can customize appearance of printed labels to
accommodate your tastes and the characteristics of
your printer. To set your preferences, choose Label
Preferences... from the Edit menu.

scroll bars adjust print image relative to the upper-left edge of the page.
0,0

Print en label edge:

® $erial number

) Free space

) Neither

[ Invert tent
[] Enpand archives

ClAlweys use small type

Border Patiern

il
) S W R LR

Title font Helvelica - -
File Name Font Times - -

Use the popup menus to choose the fonts that will
be used to print the labels. Depending upon the num-
ber of files on a disk OffLine determines the type size
required to print the file names. Since the type size
may be as small as six points, we suggest that you
select the File Name font with this in mind.

Check the “Expand archives” box if your want your

labels to show individual files within Stufflt, Compac-

tor, and AppleLink archives. If the expanded list pro-
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duces too many files to fit on a label, leaving the box
unchecked will result in the printing of archive names
but not their constituent files.

Normally, OffLine tries to fit as many file names as
possible on a label, using smaller type if necessary.
Disks containing a small number of files result in labels
printed in larger type sizes. If you prefer a consistent
appearance among your labels, then check "Always
use small type.”

Click on a border pattern that will be used to form
a border around the body of each label (the hollow
box means no border).

Select “Serial number” if you want the disk’s serial
number (assigned by OffLine when the disk was cata-
loged) to appear on the top edge of the label. Select
"Free space” if you prefer the label to show how much
space remains available on each disk. Select "Neither”
if you want only the disk name to be printed on the
label edge.

If you use Apple's LaserWriter printer driver, then
you may wish to check the "Invert text" checkbox. This
causes text on the edge of labels to be printed upside-
down, so it is readable while a diskette is in in your
diskette drive slot.

The first time you print labels, you should examine
them to ensure that the printed information aligns
correctly with the labels on the sheet. Alignment varies
slightly from one printer to another.
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The scroll bars are used to fine-tune the printing
position on the label sheet. If the alignment is off, you
can use the scroll bars to move the printed image up
to 1/4 inch in any direction, in increments as small as
1/72 inch. As you adjust the scroll bars, you can
observe the effect of your adjustments by watching
the movement of the sample label with respect to the
top and left border of the window, which represent
the top and left edges of the label sheet.

Label Description

Labels for 3-1/2 inch disks are designed to wrap
around the top edge of the disk. When OffLine prints
a label, it places information on the top edge and the
front, leaving the back blank.

HyperCard HﬂE
HyperCard ldeas

Art Ideas
Button ldeas
Card Ildeas
Stack ldeas

The top edge shows the disk's name (in 8 point
type) and either its serial number or the amount of
free space (depending on your preferences setting).
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The front of the label shows the disk name (in 12
point type) and a list of the files on the disk.

The appearance of the list of files depends upon
the number of files on the disk. Because label area is
limited and type sizes less than 6 points are virtually
unreadable, OffLine may not always be able to fit all
the file names on a label. If a disk has a large number
of files, only the first 30 names will appear on the label.

When printing labels, OffLine will try to fit as many
file names as possible on the label. However, if OffLine
detects that a disk has many more files than could be
printed (which would occur, for example, if you se-
lected a hard drive), then OffLine will alert you to this
condition, and will not attempt to print a floppy disk
label for that disk.

Exporting the Catalog

Selecting the Export... command from the File menu
invokes a standard Save as... dialog box. A default
name is suggested (see Export preferences, below), but
you can save the exported data in any folder and under
any name you choose, Click OK to create a document
containing all the information from the active catalog.

If you want to export the entries from only one disk
(rather than from all the disks in the catalog), then
select that disk and check the “Selected disk only”
checkbox, before you choose Export... from the File
menu.
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Export Preferences...

Available from the Edit menu, this command in-
vokes a dialog box in which you can set the format in
which OffLine will export the contents of its catalog.

Export Preferences
@ Export as as text file
() Export as a comma-delimited file
() Export as a tab-delimited Tile

Tewt file Tormat TeachText -

([ Concel |

If you wish to export the catalog for use in a word
processing application, choose Export as text file. The
popup menu labeled “Text file format” contains the
names of the most popular word processing applica-
tions. Choose the one you wish to launch when the
exported text file is double-clicked from the Finder.

For example, suppose you wish to export the OffLine
catalog for use in Microsoft Word. Choose Export as
text file, and pick Microsoft Word from the popup
menu. The next time you export the OfflLine catalog
(by choosing Expert... from the File menu), the ex-
ported file you create will be recognized by the Finder
as a Microsoft word document. If you double-click that
document from the Finder, Microsoft Word will be
launched, and will open the document.

If your word processor is not in the “Text file format”
menu, don’t worry. No matter what you select, the
exported document will be the same internally: plain
text. This means that you can open it by choosing the
Open command from any word processor.
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Choose Export as comma-delimited file, or Export as
tab-delimited file, if you intend to use the exported list in
a database management or spreadsheet application. Most
applications of this kind can easily open files in one of
these formats. To learn how to open a delimited file
from your database or spreadsheet application, consult
the user manual for that application.

Your export preferences also apply when you click
the Export... button in the Search window, to export a
group of files resulting from a search, and when you use
the Duplicates... command to build a list of duplicated
files.

Using Multiple Catalogs

The first time you launch OfflLine, it creates and
opens a catalog named "OffLine™ Catalog” in the folder
from which you launched the program. When you quit
the program, OffLine saves the name and location of
the catalog in a document named "“OffLine Prefs” in
your System folder. Therefore, each time you launch the
program, it opens the most recently used catalog.

If you wish, you can create and use additional cata-
logs, although only one can be active at a given time. To
create a catalog, choose New... from the File menu.
Then choose a name and folder from the Save File
dialog. Finally, click OK if you're satisfied. OffLine will
create and open the new catalog.

To switch from the current catalog to another exist-
ing catalog, the procedure is almost the same. Choose
Open... from the File menu. Pick an existing catalog
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from the Open File dialog, then click OK if you're
satisfied. OffLine will close the current catalog and
open the one you selected.
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Questions & Answers

Sometimes, when | launch OffLine, there is a message
that says “Packing catalog...” What does this mean?

If you drag a disk icon to OffLine’s trash icon (in
the Search window), the catalog entries for the
disk and all of its files are marked for deletion and
become invisible. Similarly, if you recatalog a disk
from which some files have been erased since the
disk was last cataloged, OffLine marks for deletion
any files in the catalog that no longer exist on the
disk.

In either case, the catalog entries are still there,
taking up space in the catalog (even though you
can’'t see them). However, each time you launch
OffLine, the catalog is checked to see if a signifi-
cant number of entries have been marked for dele-
tion. If so, those entries are physically removed, In
order to conserve disk space and enhance OffLine’s
performance. This process is known as packing.

The packing operation also includes integrity checks,
and the ability to repair any minor damage that
may have occurred to your catalog.
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| selected my hard disk from the Disk List and checked “Selected
disk only.” Then | clicked Search, without specifying any search
criteria. An alert said that there were too many matches to
display. How can | view all the files on this disk?

The Search command is designed to display a limited number
of files that match your search criteria. If you want to browse
all the files on a disk, double-click or option-click a disk in the
Disk List.

What are archives?

An archive is a file that contains one or more other files in
compressed format. The practice of storing related files in an
archive is common on electronic bulletin board systems, be-
cause it makes file transfers easier and quicker. Stufflt and
Compact Pro are two commonly-used archiving applications on
these bulletin boards. Their names usually end with “.SIT" and
" .CPT” respectively. Archives used on AppleLink are called
packages, and their names usually end with a “.PKG" exten-
sion. If you have disks containing archives, then OffLine will
recognize them and extract information about their contents.

DiskDoubler is another compression program supported by
OffLine. Although DiskDoubler can create archives of a kind
(“combined files”), it is normally used to compress individual
files. Finder describes these files as DiskDoubler documents,
and technically, they are. Fortunately, OffLine’s catalog engine
actually peeks inside of them to determine what they were
before being compressed, and catalogs them accordingly. The
result is that a search for, say MacWrite documents will find
even those that have been compressed by DiskDoubler.

What can (and cannot) be cataloged by OffLine?

OffLine can catalog any type of disk volume that is attached to
your computer and that can be mounted by Finder. This in-
cludes hard disk partitions and some streaming tape drives.
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Some network servers use a proprietary file system, so
such server volumes cannot be cataloged remotely. MS-
DOS disks can be cataloged if you use special software
that allows Finder to mount them.
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Appendix

Export Format (Comma- or Tab-delimited)

If you export the OffLine catalog m delimited format,

then OffLine will produce a structured file suitable for
use by most database and spreadsheet applications. To
make it easier for you to import the resulting file to
another application, the format of the exported file is
presented here.

The exported file consists of one record for each file

in the OffLine catalog. Each record consists of 9 fields. In
a comma-delimited file, each field is enclosed in double
quotes, and fields are separated (delimited) with a comma.
In a tab-delimited file, there are no quotes, and fields are
separated by a tab character.

1.

Disk serial number, as assigned when the disk was catalogued.
Example: 226

Full pathname, consisting of the disk name and any folder names, if
the file is in a folder.
Example: My Program Disk:Letters:July

File name
Example: Letter to Mom

File description
Example: MacWrite document

File creation date
Example: 7/12/90

Last modification date (or version number)

File size, in bytes.
Example: 28603

File creator
Example: MACA

File type
Example: WORD
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